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Features Added to WireReady32 in Version 7
WireReady32 is the product family name that refers to the following software applications:
NewsReady, ControlReady, and SalesReady.   All 3 products are contained in the same EXE file 
that makes up our software, but each product's screens are accessible only to customers who 
have licensed those products.  For example, if you use NewsReady you may notice that the 
Sales, Automate and Live Assist buttons are grayed out. If you use only SalesReady, you will 
notice the Automate and Live Assist buttons are grayed out.  Generally speaking, machines 
licensed for ControlReady and/or SalesReady automatically have access to the news/copy 
writing screens too.

This document describes all major changes and improvements to WireReady32 in version 7.0, 
broken out based on each product.   WireReady32, NewsReady, ControlReady and SalesReady 
are products manufactured, sold and supported by WireReady NS Inc.  The WebReady product 
is mentioned because WebReady also utilizes WireReady32, along with additional web 
publishing software.
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Version 7 Information and Bulletins
WireReady NSI has made many improvements to the software over the past year, in both 
improving the performance of the program and adding additional features.  Many of these new 
features are described below, along with information on how to configure the settings for them.  
Each description gives the division of WireReady NSI that the new feature is used in.  The 
features are listed by version within each section, with the newest at the top.  
Please contact WireReady NSI if there are any questions about how to set up or use any of the 
described features.

Version 7.0 is our newest release and if anyone reports a bug we will issue a new version 
above.

When introduced in Jan of 2007, Version 7.0 used all the source code from Version 6.0 plus 
new code we added in the 6.5 series which was used by select customers from 1/11/2006 
thru 1/15/2007 to prepare for Version 7's debut.

With very slight exceptions Version 7 now ONLY receives bug fixes. Customers on version 7 
who download the latest version above have a low chance of receiving a bug because the 
above version is virtually the exact source code you run now, except for a few bug fixes.

Note:  ANY CUSTOMER USING VERSION 6.5xx should upgrade to version 7.0 ASAP.
          ANY CUSTOMER USING VERSION 5.5xx should upgrade to version 6.0 ASAP.
          Version 5 and later will ONLY run from 2000 and XP.

Attention automation and 1616 users: Anyone using a 1616 relay controller, or who uses 
COMTALK, Pulse/Latch, and WAIT FOR CHANNEL based commands with version 3.823 or 
later - must be using Win2000/XP, as the commx.ocx driver file is no longer used nor 
supported. Customers who use these features should upgrade to 2000/XP before going to 
any version higher than 3.823. However, Win95/98/ME may still be used without difficulty 
with all other functions/features of the software. If you don't use the mentioned features, 
there is no need to upgrade your operating system at this time.

Attention Windows 95 and Windows 98 users: Versions 4.500 and higher of WireReady32 
only support Windows 2000 and Windows XP. Users with versions of Windows prior to 
Windows 2000 should only use versions of WireReady lower than 4.500.

BULLETINS:
* Version 7.0 is compatible with European and Asian Time Zones (GMT +1 thru GMT +12).

HOW TO HANDLE DAYLIGHT SAVINGS TIME IN FALL:
Warning: Be careful how you use BE HERE AT and WAIT UNTIL commands in automation on 

the 1st Sunday of November when we fall back for Daylight Savings Time with version 4, 5 
or 6 of our system. If you don't use these commands between 1am and 2am Sundays then 
this bulletin does not affect you.

The way that Windows reports time to our automation decks with ControlReady causes two 
commands within automation to act other than expected for one hour on the day that 
daylight savings time ends. This occurs because there are two hours that start at 01:00:00 
and end at 01:59:59 in Windows Time - i.e. there are two 1 o' clock hours.  If you wait until 
1:00:00 on the 1st Sunday of the month, the system will actually wait until 2:00:00 am 
sitting there an extra hour. A Be Here At will not preempt any programming that passes 
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1:00:00am and it will also wait until 2:00:00 am. Of course as soon as 2:00:00am occurs, 
the clock will say 1:00:00am and it will then move forward.

These two commands are Wait Until and Be Here At. For these two commands, for the hour 
before daylight savings time ends (1:00:00am until 01:59:59am) times are treated as if they 
are after daylight savings time ends. So, for example, if you have Wait Until 01:05:00, 
Wireready32 automation will wait until 5 minutes after daylight savings time ends. Your 
computer clock will show a time later than 01:05:00, but Wireready32 automation will not 
move on until an hour after you would expect.

For this one hour, one day a year, you will need to make changes to your Sunday playlists if 
you use either Wait Until or Be Here At in the 1am hour.

If you use other time commands like IF TIME - they are not affected and treat time just as you 
see it.  They will follow what you actually see on the windows clock on the lower right hand 
of your screen.

If you want the system to auto-adjust for daylight savings time - make sure that Windows is set 
to adjust for Daylight Savings time. You can do this by double-clicking the clock in the 
lower-right corner of Windows, and checking the box on the time zone tab.

If your Sunday Playlist uses the two affected commands - you can make the following changes:
a. Create a duplicate 1am hour. You will then have two 1am hours consecutively. You can 

easily do this by pasting (with Ctrl-V) the existing 1am hour directly below itself, and 
unchecking the "increment hour" box.

b. Any place you have Wait Until or Be Here At commands in the 1am hour, you will need to 
make changes to the FIRST 1am hour. Remove the Be Here At commands. Replace the 
Wait Until commands with If Time is Before commands.  The way you set up the If Time 
commands is be having the GoTo field be the line this IF command is on. For example, if 
you have Wait Until 01:05:00 in the playlist, on line 152, replace this with "If the Time is 
after 01:05:00 then continue with next line; Else goto line 152". It is important that the 
"goto line" number be EXACTLY the same as the line you are putting this command on.

If you have any questions you can call our support department.
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NewsReady Improvements (for customers licensed for NewsReady)

Toolbar Buttons and Menu Items for Quick Searches Added
Buttons have been added to allow users to set a WireBrowser Custom Search as a Quick 
Search. When using F2 to bring up the list of searches, the Search Options window now 
contains 4 additional buttons along the right side of the window (Set Search1 thru Set 
Search4).
To setup a Quick Search, highlight a search from the list in the Search Options window.  Then 
click on a Set Search button to set that search as a Quick Search with that number.  
To use the Quick Search, either strike Ctrl+Shift+[#] on the keyboard, or choose the search 
from the View pull-down menu.
These buttons use ini-defined indexes for their search. The indexes default to 1-4, and are 
contained in the [CommonBrowser] group of the user’s ini file.  The number of the Custom 
Search is stored for the quick search.

[CommonBrowser]
QuickSearchIndex1=17
QuickSearchIndex2=12
QuickSearchIndex3=14
QuickSearchIndex4=19

Print with Header option for Notepad
The Notepad and FileLog stories, when printed, can have additional information added to the 
top of the printout.  The Setup menu choice now includes a Print With Header choice.
When checked, the following information will be added to the top of the printed story:

 [STORY SLUG]
[WIREREADY USER NAME]  [SECURE NAME (if in secure mode] 
MM/DD/YYYY  HH:MM:SS     [WIREREADY VERSION#]

This text is only added to the printed text file and will not be saved to the story.

Add Postiex support to the Notepad’s Email button
WireReady32 can now send emails from the Notepad using Postiex.  This will allow users to 
send text and audio without having to run Outlook or other email programs.  The audio will 
be compressed to MP3 format.  Emailing will only work with Windows2000 and WindowsXP.  
Each workstation that will be sending emails will need to register Postiex and be configured 
for the email sending.
The WireReady32 program needs to be configured for sending email using Postiex.  Each user 
has an “ini” file that holds the configuration settings.  This is located under the \wire\users\
folder, in a folder with the username.  For example, the user called “News1” will have the 
“w:\wire\users\news1\news1.ini” file that needs to be edited.  These configuration settings 
can be edited using Notepad or WordPad.  The following group contains the settings in the 
user’s ini file:

[Postiex]
SMTP Server=            The SMTP server used for the email account.
User ID=                    The username for the email account.  This may be different than 

the email account name.
Password=                 The password for the email account.  This is case-sensitive.
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Notepad Email To=    This field will be filled in when an email is sent out, and it stores 
the last email addresses that were sent to.  This field can be left blank 
during configuration.

Email From=              The email address of the account sending the email.
Email Mode=Postie     This must be set to “Postie”
Send Startup Via Postie=   Determines if an email will be sent when the WireReady32 

program is started.  Valid parameters are Yes or No.
Startup Email To=      Email address to send to when the WireReady32 program is 

started.

Edit the lines to include the valid settings for an email account.  Each workstation user can be 
set with the same email account and settings, since these settings will only be used to send 
the emails.

Fixed Handling of European and Asian Time Zones
Fixed time zone handling of European and Asian time zones.  Added a handler to where the 
date is converted from a string into a Ctime. This allows us to read existing audio files. If the 
year is less than 1980, it will convert the year to 1980.
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ControlReady Improvements (for customers licensed for ControlReady)

Change Command Path 
A new menu choice has been added to the Automate screen’s Edit menu called Change 
Command Paths.  This can be used to change the paths specified in commands in a playlist.  
Rather than having to edit each command by hand, Change Command Paths can be used to 
modify paths within the playlists.
Enter the Old Path currently in the playlist and the New Path to change it to.  This will modify 
the following commands:  AutoRecord, Change Path, Play Wave, and Play Wave Rotation (the 
path of the audio file, not the path of the rotation file).
This can only be used on the playlist loaded in the deck, and will not modify all playlists at 
once.

Automation Deck Lockdown
When a playlist is running, it is possible to accidentally hit the F4 Stop button and cause the 
playlist to stop.  Users can now set each deck to be “locked”, which will give a warning when 
a user attempts to start or stop a deck.  
The setting is under the View menu on the Automate Decks.  Each deck is set independently, 
so the user must check the Lock Deck menu choice for each deck to be locked.

The text of the warning window is:
WARNING – THIS DECK IS LOCKED!
You are about to start this automation deck.
Are you sure you want to start this deck?

or
WARNING – THIS DECK IS LOCKED!
You are about to stop this automation deck.
Anything playing or recording (or doing anything else) will stop.
Are you sure you want to stop this deck?

Date Option Added to IF command
The IF command in Automation now allows the user to have the command be controlled by 
Date, in addition to Time and Channel.  The Date section has 3 options in the pull-down 
menu:  Before, On and After.  The Date is entered in the format MM/DD/YYYY, where MM is 
Month, DD is Date, and YYYY is the year.  If the user does not enter the slash (/), the 
program will enter it automatically.
In the playlist, the date is displayed as MM:DD:YYYY.

Date Macros Added to ComTalk command
Macros can now be used for dates in the Command String within the COMTalk command.  
The macros are case sensitive.

The macros are:
[DATE] = MM/DD/YYYY
[date] = m/d/yy
[M] = Month MM
[m] = month m
[D] = Day DD
[d] = day d
[Y] = Year YYYY
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[y] = Year YY

FadeToStop Added to both the Deck and Presets of LiveAssist2
The Automation Decks have the ability to fade a playing audio file if the user needs to stop 
the audio in the middle of the file.  The Live Assist2 screen now has the ability to do this also.
A menu item has been added to both the playing Deck and the Preset buttons that allows the 
user to fade the audio as it stops the play.
Right-click on the deck or preset button as it is playing.  Choose the Fade To Stop menu item.  
This will cause the playing audio file to fade from full volume over a 5-second period, and 
then stop playing.
Choosing the Fade To Stop in the decks along the left side of the screen will not affect the 
audio playing in the Preset button.  Choosing Fade To Stop in the preset buttons will not 
affect the audio playing in the deck.

Load And Start dialog
In previous versions, the Load and Start command launched a File Select window to allow the 
user to choose the playlist to have in the command.  It now launches a Load Playlist window, 
which is the same as the window launched when loading a playlist manually into a deck.

Ability to Schedule Out of Date carts upon Importing
In previous versions of WireReady32, when carts were out of date and the system was set to 
Obey Start and Stop Dates, the audio files would not be scheduled in the playlist upon 
importing.  Some stations like to have the cart scheduled, but show as Missing or Out of Date.  
This allows them to review the invalid files and make corrections without having to re-import 
their logs.
A new line has been added to the [Automation] group in the user’s ini file:  
bScheduleOutOfDateCarts=.  When set to Yes, carts that are out of date will still be scheduled 
in the playlists.  These files will not play unless the date or time is adjusted on the file.

Schedule Missing Support for Import
When importing from the Traffic or Music logs into a playlist, if a file did not exist or was out 
of date, it was not scheduled in the playlist.  The Import Report notified users which files 
could not be scheduled.
The ability to have missing and out of date files scheduled in the playlist has been added.  
The audio files will still display as missing in the playlist, but this gives the station the ability 
to import files that have not been created yet.  When the files are created, they will already 
be scheduled in the playlist.

The following keys have been added to the user’s ini file:
[Automation Import]
Schedule-Missing-Files-Enable=No
Schedule-Numeric-Range-Enable=No
Schedule-Prefix-enable=No
Schedule-Min=9000
Schedule-Max=9999
Schedule-Prefix=VT_
Tolerance-Warning=no  
TreatMissingFilesAsComments=No
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For the import to schedule missing files, you must set TreatMissingFilesAsComments=No and 
Schedule-Missing-Files-Enable=Yes. 
You must also set either Schedule-Numeric-Range-Enable=Yes or Schedule-Prefix-
Enable=Yes; or you can set both Schedule-Numeric-Range-Enable=Yes and Schedule-Prefix-
Enable=Yes. That is, at least one of them must be Yes.
If you set Schedule-Numeric-Range-Enable=Yes then you need to set the numeric range, 
using Schedule-Min= and Schedule-Max=. For example, if you want to schedule missing 
commercials, and you use 5-digit numbers between 10000 and 59999 for commercials, then 
you would set Schedule-Min=10000 and Schedule-Max=59999.
If you set Schedule-Prefix-Enable=Yes, then you must set the prefix, using Schedule-Prefix=.
For example, if you want to schedule voice tracks even if they do not yet exist when you 
import the music log, then set Schedule-Prefix=VT (assuming your voice tracks all have 
filenames beginning with VT).

If your user's INI has
Schedule-Numeric-Range-Enable=No
Schedule-Prefix-Enable=Yes
Schedule-Min=
Schedule-Max=
Schedule-Prefix=

then all missing files will be scheduled. The key here is Schedule-Prefix-Enable=Yes and 
Schedule-Prefix=: we have told it to use a prefix, but since we don't specify a prefix,
everything qualifies.
Be aware that this can cause comments that are in the traffic log to be treated as files. For 
example, if your log has information at the top, such as "WNSI Music log for 09-21-2006"; or 
you have things like "News" or "Live" in the column where the filenames would normally be, 
these will be treated as files, and will be scheduled, even though they are missing. Since 
these don't exist, nothing will play, and it will still sound correct on the air. But it might look 
odd when you are looking at the screen.

Added a Setup screen to FileSelect.
A new button has been added to the FileSelect window that launches when adding new audio 
files into the playlist.  The button, called Setup, allows users to enable or disable refreshing of 
the folder in the FileSelect window.  Some customers will want any new file to be displayed 
anytime they access the FileSelect window.  Others will not want to wait for the refresh of the 
folder to occur, and will want to disable the statements, opting to do a manual refresh.
The following statements can be checked or unchecked:

Pickup latest file changes from the current folder EVERYTIME you load another file.
If not checked, you will only see the list of files from the last time you looked at the 

folder.
If not checked, the latest changes are only picked up when you hit SELECT folder or hit 

the REFRESH button.

Pickup latest file changes to the folder anytime you SELECT a folder.
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Pickup latest file changes to the current folder EVERYTIME you search for something with 
the Filter Choice.

If not checked, we will search using the current displayed contents of the folder.

CounterPoint Import / Confirmation Log
Importing the CounterPoint log into the WireReady32 playlists is now configurable in the 
user’s ini file.

To use import from a CounterPoint log you have to set the line 
“ImportTrafficLogFormat=CounterPoint” in the [Automation] group.

To view the Imported data that was imported using CounterPoint, two new menu choices 
have been added to the Edit menu in the Automate Decks.

1) Audio Info   CTRL-I
This brings up the standard INFO dialog window that is also launched in the MediaLog 
and Live Assist screens.  

2) Audio Recon Log Info   CTRL-L
This launches an Audio Recon Log Info window, which displays the Audio Filename, 
Import Filename and Import Log Line.  In addition, it contains the following text:

This information was pulled in when we imported your traffic log and is only specific 
to THIS occurrence of the selected audio file in the log.  No information is displayed 
if you didn't import a traffic log that supports reconciliation.  
No information is displayed for events that weren't imported from your log.

To have a record of audio files that played in a CounterPoint confirmation file, you have to set 
the deck number that the playlist runs in to CounterPoint in the [Confirmation Log] group.
Assuming that you are playing from Deck #1, you would edit the user’s ini file to have the 
following:

[Confirmation Log]
1=CounterPoint

Changed the name of the Log command to Tech Log
The LOG command is now called Tech Log.  If you already have the Log command in your 
playlists, you do not need to change anything.  The command will now display at Tech Log in 
the Command column of the Automate Decks.

Stop Date Configuration for Voice Tracks
When recording Voice Tracks, the default Stop Date is set to 6 days from the current date.  
The Stop Date is now configurable to allow a user to set a different period of days.  
The user’s ini file now has an additional setting:

 [Voice Track]
StopDateInDays=6

This setting is configurable per user, which allows for each user to record voice tracks with a 
unique end date.
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Changes to the Import Report Format
The Import Report display has been modified to include the Time, Description, Length, 
Seconds Off, if it exceeds the tolerance (> +/-) and the End Time for each of the Scheduled 
Breaks.  The columns have also been cleaned up to allow them to always be lined up.  

Warn On Stop and Warn On Exit
When using the mouse or keyboard to navigate in the Automate Decks, it is easy to choose 
the incorrect function and cause the playlist to stop using F4.  In order to protect the 
automation from accidentally being stopped, an additional menu choice has been added 
under the Setup menu.  
Click on the Warn on Stop choice under the Setup menu to enable the warning for this deck 
when F4 Stop is activated.  A window will pop up warning that the user is about to enable this 
feature, with the following text:

STOPPING OF AUTOMATION IS NOT LOCKED
You are about to warn people when they try to stop this automation deck.
Do you want someone to have to enter a password to stop this automation deck?

Click the Use Password statement and enter a password if users will have to enter a password 
to stop the deck.  If not requiring a password, just click the OK button.
Note:  This will only affect the deck that is currently displayed.  To give the warning on other 
decks, you must enable this feature on each deck.
When Warn on Stop is checked, a window will pop up when F4 Stop is activated, with the 
following text:

WARNING!
You are about to stop this automation deck.
Anything playing or recording (or doing anything else) will stop.
Are you sure you want to stop this deck?

If a password has been set, the user will need to enter the password to have the automation 
deck stop.  If no password was set, the user can click OK to stop the deck, or Cancel to leave 
the deck running.  
The warning and password can also be configured in the user’s ini file, under the following 
section:

[Automation Deck 1]
Stop Lockdown=Yes
Stop Password=

In addition to warning when a deck is stopped, a warning can be enabled when a user 
attempts to exit the entire program.  This is also found under the Setup menu choice.
Click on the Warn on Exit choice under the Setup menu to enable the warning for the 
program when Alt+F4 is struck or the X is clicked.  A window will pop up warning that the 
user is about to enable this feature.   Click the Use Password statement and enter a password 
if users will have to enter a password to exit the program.  If not requiring a password, just 
click the OK button.
Note:  This will affect the entire program, and will launch the warning from anywhere it the 
program.
When Warn on Exit is checked, a window will pop up when Alt+F4 is struck or the X is clicked, 
with the following text:

WARNING – AUTOMATION IS RUNNING.
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If the system is playing or recording, you can take your station off the air or kill a 
program (if one is being recorded).  Make sure your automation programs are 
idle/waiting and you won’t interrupt any programming. 
Are you really sure you want to exit Wireready32? (Choose Cancel to double check your 
automation programs before exiting)

If a password has been set, the user will need to enter the password to exit the program.  If 
no password was set, the user can click OK to exit, or Cancel to leave the program running.  
The warning and password can also be configured in the user’s ini file, under the following 
section:

 [Automation]
Warn On Exit=Yes
Warn On Exit Password=

Schedule Music Command
Many customers would like to be able to schedule music without using a music-scheduling 
program.  WireReady32 now allows Scheduled Music Sweep commands to be filled in using 
the Schedule Music menu choice.

From the File menu, choose Schedule Music.  The Import Status window will pop up and show 
the number of files imported into the playlist.  The music files will be scheduled using the 
configuration settings in the user’s ini file.

The following ini lines are created the first time the user tries to Schedule Music.  The values 
can then be edited if the default settings do not meet the needs of the station from the Setup 
menu.

[Music Schedule]
Folder=W:\Music\    The folder that the music files will be scheduled from. 
Filename Separation=10    The number of songs apart a song with the same 

Filename has to be.
Artist Separation=10    The number of songs apart a song with the same Artist has 

to be.
Description Separation=100    The number of songs apart a song with the same 

Description has to be.
Number Of Files To Keep In History=1000
Max Retries For Unusable Cuts=100    Maximum number of files to try when the 

files unusable until the beak is considered full.
BreakTolerance=30    Number of seconds above or below the break length that is 

acceptable for each Scheduled Music Sweep command.

After the music is scheduled, the Scheduled Music Sweep command will display the amount of 
time short or long the break is under the Status field in the playlist.

AutoFill and Check Fill Rotations added to the Setup menu
Configuration of the AutoFill can now be done from the Setup menu in the Automation Decks.  
The AutoFill Setup window allows the user to set the path for location of the autofill files.   In 
addition, the user can set the program to fill the Scheduled Music Sweep and Scheduled Break 
commands at any time or at the time the command is executed.
The autofill is only active for commands that have the “Fill Break Exactly” statement checked.
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In addition, users can check to be sure that the fill rotations exist in the proper location for 
them to be used in the Scheduled Music Sweep and Scheduled Break commands.  Choose 
Check Fill Rotations under the Setup menu, and it will display if the necessary files exist.

Support for Input Channels for Additional Devices
WireReady32 now has the ability to look for the burst strings when a logic input changes for 
devices other than Broadcast Tools switchers.  

If you are monitoring inputs on a device other than a Broadcast Tools switcher, the  
“Manufacturer=” line will need to be added to the user’s ini file under the [Pip1] group.  
Possible Manufacturer options are: BroadcastTools, SAS, SRC2, Custom.

[Pip1]
Port=1
Manufacturer=SRC2

Broadcast Tools (default)  Works with all SS type switchers.
SRC2  Works with the SRC2 device from Broadcast Tools.
SAS Works with SAS Rubicon consoles.  For more details on Rubicon, contact WireReady.  
Note the Custom mode will work with SAS, but SAS uses preset string types for Rubicon 
consoles.

It is also now possible to send strings to a COM port without using any device, using 
“Custom” as the manufacturer.  The CUSTOM ini strings default to what is needed to interface 
to the SRC2, and parameters are contained in the ini section "Custom PIP":

[Custom PIP]
Start Of Input String=*
End Of Input String=|[|]
NumberOfInputs=1
Input%dLowString=*0%d0
Input%dHiString=*0%d1
NumberOfOutputs=1
Output%dLowString=*0OR%dL|[
Output%dHiString=*0OR%dF|[

Substitute "%d" for the input or output number starting from 0. 

To represent common non printable characters:
"|[" = CR
"|]" = LF
"|@" = Esc

So a pipe and [  is Carriage Return, a pipe and ] is Line Feed, and a pipe and a @ is 
Escape.

Super Rotator for Importing into Automation
A new feature has been added to how we import traffic/music logs that lets a customer set up 
something similar to a rotation file, except instead of scheduling ONE play command (the 
"next up" cut) for the name on the log, it will insert an ENTIRE LIST of play commands from 
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that same rotation file into the playlist.  These files are referred to as Super Rotators. 
 For example, if the super rotator called DAVID consists of:
[file1]
[file2.rpl]
[file3.wav]
we would insert file1, file2, and file3 back to back in the playlist in place of DAVID.

A Super Rotator is created the same way as a regular Rotation file by using the Notepad.  
When hitting the F4 Save button, the Text File Header window now includes an additional 
checkbox for “Save As SRP Super Rotator for Automation”.
The Super Rotator is accessed and edited thru the FileLog, and follows the same rules as the 
regular Rotations.  The file extension of a Super Rotator is “srp”.

The user’s ini file has new lines to allow configuration of the Super Rotators:
[Super Rotator]
Enable=No
UseNumericRange=No
UsePrefix=No
Min=8000
Max=8999
Prefix=SRP

In order to use super rotations- you must have the Enable= set to yes.
You can have the program recognize super rotations as apart from regular rotations by 
specifying either a numeric range of file name numbers or using a prefix in the file names.
For example, if your prefix is SRP, then any file names in your log beginning with SRP will be 
treated like super rotations if the super rotation feature is enabled.

Ability to Extract Info fields when Ripping CDs
When ripping audio from CDs, it is now possible to have that information entered into the Info 
fields in the WireReady32 MediaLog.  The CD extraction program you will need to use is called 
AudioGrabber, a freeware program that can be found at http://www.audiograbber.com-
us.net/.

Some changes will need to be made to the WireReady32 user configuration file to have the 
information display properly.  Edit the user’s configuration file, which is 
w:\wire\users\[username]\[username].ini, where [username] is the name of the user logging 
into WireReady32.  Open the file with Notepad or Wordpad.  Use Edit/Search from the 
menu to search for [WaveLog].  If the following group does not exist, add it at the end of 
the user’s ini file.  Then close and save the file.

[WaveLog]
EnableExtractInfoFromFilename=Yes
ExtractInfoFromFilename=AudioGrabber
ExtractInfoFromFilenameLog=C:\Temp\ExtractInfoFromFilenameLog.txt
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RDS to DBCapture publishing
For WireReady NSI customers who are using our ControlReady for Windows and WebReady 
products, who would also like to post the currently playing audio file to their website, 
ControlReady can now send data to a file that DBCapture can publish.

The files are written to the folder specified in the user’s ini file under:
[RDS]
OutputFolder=

This creates a *.txt and *.dat file. The files are named in the current time in HHMMSS format 
(HHMMSS.txt and HHMMSS.dat). The text files set:

NR32_SCRIPT1
FILESLUG:
FILECATG:
FILEWHOM:
FILEWRIT:
FILEDATE:
FILESHOW:
FILETIME:
FILENEXT:
FILECMD1: = Command=ReplaceTextOnly 
FILEUS01: = User1 = Artist
FILEUS02: = User2 = Description
FILEUS03: = User3 = Filename
[path and filename]

The Command line will always be ReplaceTextOnly.  The Artist, Description, and Filename will 
be pulled from those fields in Info screen available in the MediaLog.
As DBCapture processes the *.txt and *.dat files, they are removed from the Output Folder.

Fixed Handling of European and Asian Time Zones
Fixed time zone handling of European and Asian time zones.  Added a handler to where the 
date is converted from a string into a Ctime. This allows us to read existing audio files. If the 
year is less than 1980, it will convert the year to 1980.
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SalesReady Improvements (for customers licensed for SalesReady)

Fixed Handling of European and Asian Time Zones
Fixed time zone handling of European and Asian time zones.  Added a handler to where the 
date is converted from a string into a Ctime. This allows us to read existing audio files. If the 
year is less than 1980, it will convert the year to 1980.
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WebReady Improvements (for customers licensed for Web Publishing)

RDS to DBCapture publishing
For WireReady NSI customers who are using our ControlReady for Windows and WebReady 
products, who would also like to post the currently playing audio file to their website, 
ControlReady can now send data to a file that DBCapture can publish.

The files are written to the folder specified in the user’s ini file under:
[RDS]
OutputFolder=

This creates a *.txt and *.dat file. The files are named in the current time in HHMMSS format 
(HHMMSS.txt and HHMMSS.dat). The text files set:

NR32_SCRIPT1
FILESLUG:
FILECATG:
FILEWHOM:
FILEWRIT:
FILEDATE:
FILESHOW:
FILETIME:
FILENEXT:
FILECMD1: = Command=ReplaceTextOnly 
FILEUS01: = User1 = Artist
FILEUS02: = User2 = Description
FILEUS03: = User3 = Filename
[path and filename]

The Command line will always be ReplaceTextOnly.  The Artist, Description, and Filename will 
be pulled from those fields in Info screen available in the MediaLog.
As DBCapture processes the *.txt and *.dat files, they are removed from the Output Folder.

Fixed Handling of European and Asian Time Zones
Fixed time zone handling of European and Asian time zones.  Added a handler to where the 
date is converted from a string into a Ctime. This allows us to read existing audio files. If the 
year is less than 1980, it will convert the year to 1980.
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